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What is a Transcriber?

A transcriber is an end user authoring tool that allows the reader to create their own browse sequences.
Pages of any Viewer title can be collected into a custom browse sequence which can be annotated with
text or sound. These annotations and browse sequence data are stored in an external file which can be 
distributed in the form of    Transcript files. These transcript files become Double-Clickable lesson sets 
that can be used to guide the reader across multiple Viewer Titles in any sequence.

While Viewing the transcript the reader is automatically exposed to annotations and sounds that are 
associated with each page. For more information on how to use this authoring tool see the end user 
documentation.



How do I implement it in my Viewer Title?

The work required to support the Transcriber on the developer side is very small. Include the following 
data in the [CONFIG] section of your title:

RegisterRoutine("mvtran","HideShowTranBar","U")
CreateButton("Tran","Tra&nscriber","HideShowTranBar(hwndApp)")

That's it. This will create a Transcriber in your button bar. After that the development work is in the 
hands of the reader !

If you want to make your transcript files double click-able make sure to distribute the TRLAUNCH.EXE 
application. Remember, this app also requires VBRUN300.DLL. Associate the TRN extension with the 
TRLAUNCH.EXE app. This will provide an Icon and double clickability into transcript files. Add the 
following line to your WIN.INI file, of course adjusting the path for your environment.

[Extensions]
TRN=C:\VIEWER\TRLAUNCH.EXE ^.TRN



Licensing MVTRAN for redistribution.

Keyboard Publishing owns and distributes MVTRAN as part of its commercial Viewer products. We 
have made this product available to developers in the hopes of fostering development with Multimedia 
Viewer. This is a full, working version of the MVTRAN Viewer Extension.

You are welcome to use MVTRAN in your development and in house projects. If, however you wish to 
resell or distribute MVTRAN as part of a commercial package a license is required. Please contact 
Keyboard Publishing at the address listed below.

This product was conceived and developed by William Reichardt, an employee of Keyboard 
Publishing for Multimedia Viewer 1.0 and has been tested and been proven compatible with Viewer 2.0.
Keyboard Publishing is not responsible for upgrading or supporting unlicensed customers. Inquiries and
questions about this program should be directed via Compuserve Mail to our Technical Support 
Department.

MVTRAN is © Copyright 1993 by Keyboard Publishing

If you have any further ideas for new capabilities for this extension please drop me a line via 
Compuserve at 71151,253 or Internet 71151.253@COMPUSERVE.COM.



Other Viewer Extensions from Keyboard Publishing.

We are always interested in new ideas for Viewer extension products. If you or your company need 
custom development work for Viewer extensions please contact us.

We currently have the following products available for Viewer 2.0.

MVScript and The Viewer Commander
A command line/scripting environment for Multimedia Viewer. Allows you to use external script files to 
store Viewer Macro Commands. The files can later be enclosed in Baggage.

Score DLL
The score DLL allows you to create Viewer topics that ask questions and keep score for the student 
providing feedback on learning.

More products are in the works and will be available soon!



Keyboard Publishing Transcriber    Help

The Keyboard Transcriber floating tool palette was designed to allow you to create custom lesson sets 
for a student studying the material in a Keyboard Viewer document. It allows you to record a sequence 
of pages in a TextStack, VideoIndex or QuizBank and then arrange them in any order for playback in 
the form of a lesson. Each page in a transcript may have additional text attached to it which can be 
displayed in a floating window during playback. Each page may also have a sound attached to it as 
well. Once you have developed a lesson it may be saved for later playback in a file with the extension 
*.TRN. The Transcriber will only work with products produced by Keyboard Publishing.

For more information, click on a button in the palette shown above .

( Developer Note: The documentation show here is taken from our end user documentation. It is given 
here because it provides a good description of all the transcriber's functions. Please ignore any 
references to Keyboard specific stuff like TextStacks, Quizbanks ect..)



 The Forward Button    
The forward button will cause Viewer to jump to the next page in an open transcript. If no transcript is 
open it will do nothing. If you have set the Continuous Animate option in the setup area of the Transcript
Editor Window, the play button will toggle automatic animation between pages on or off. 

NOTE : This button will not function if the Record button is down.



 The Reverse Button

The reverse button will cause Viewer to jump to the next page in the transcript. If there is no document 
open it will do nothing. If you have reached the first entry in the transcript it will also do nothing.

NOTE : This button will not function if the Record button is down.



 The Transcript Editor Window Button

This button will show or hide the Transcript Editor Window when it is depressed. This window displays 
your current position in the transcript. Hiding this window does not erase the transcript.



 The Record Button

This button activates transcript recording. While this button remains down all pages you turn to in the 
Viewer will be added to the bottom of the transcript you have open in any Keyboard Stack you view. 
While the record button is down the following buttons will not function: Forward, Reverse and File.



 The Snapshot Button

This button allows you to add whatever page you are currently viewing to the open transcript file. It will 
be appended to the bottom of the transcript list.

NOTE : This button will not function if the Record button is down.



 The File Button

This button will display the file open box to open a transcript. This button duplicates the function of the 
File Open menu in the transcript editor window. If a file is already open you will be offered the chance to
save the currently open file if changes have been made. 

NOTE : This button will not function if the Record button is down.



The Transcript Editor Window

The transcript editor window displays all off the pages included in the transcript in the order in which 
they will be played back. This window can be used to re-order, edit or delete information about a page 
in the transcript. The transcriber's preferences can be set from here as well.

 In the left hand margin of this window a small notation image for a text annotation and an audio 
annotation can bee seen.

In the Menu bar of this window there is a File Menu, an Edit Menu ,a Page Menu and a Setup Menu 
used to modify the transcript list.



 The File Menu

The File menu contains all operations involving saving and loading transcripts into memory. Only one 
transcript file may be open at a time.

The New Command Clears the current transcript out of memory and creates a blank transcript to begin
recording.

The Open Command allows you to open a previously saved transcript file for playback. Transcript files 
have the extension .TRN. 

The Add Topic Command Performs the same function as the Snapshot Button.

The Save and Save as... commands allow you to save a new or edited transcript to disk. 

The About Command allows you to view a window displaying the name and version of this program.



The Edit Menu

The edit menu contains the standard Windows editing commands. They can be used to cut and paste 
transcript entries to different locations in the transcript. When inserting a transcript item remember that it
will appear below the currently selected item in the list.

The transcript editor window does not support the standard Windows clipboard. Text cannot be pasted 
into it nor can transcript information be cut out of it and placed into another application. All cut and paste
functions use an internal clipboard.



The Page Menu

The page menu contains commands used to turn from page to page and to edit the properties of any 
particular transcript list member.

The Next Command advances the selected line to the next item in the list without actually turning to 
that page. 

The Previous Command moves the current position of the selected line backwards to the previous 
page without actually jumping to that page.

The Goto Command Jumps to whatever page is selected in the list.

The Text Annotation... Command Opens    the Text Annotation Dialog Box to edit the comment text 
attached to this page.

The Audio Annotation... Command opens up the Audio Annotation Dialog Box to allow you to edit the 
sound attached to this page.



The Setup Menu

The setup menu allows you to control the way the Transcriber functions. It allows you to set playback 
options and record author information in a transcript file.

The Author Info ... Command brings up a dialog box which allows you to record your personal 
information in a transcript such as your name, the date and the topic of the material covered. This 
information is saved into the transcript file.

The Playback Options ... Command brings up the Playback Options dialog which allows you to set 
the following properties.

Play Audio Annotations - This option will cause audio annotations to be played as soon as a new 
page is selected using the Forward or Reverse Buttons. If this option is off sounds may still be played 
by means of the Sound Button which appears in the button bar of the Transcript Text Window.

Show Text Annotations - This option will cause the Transcript Text Window to appear or become the 
selected window whenever a page is turned using the Forward or Reverse Buttons. If this option is off 
the Viewer will turn to the requested page without displaying the attached text.

Continuous Animate - If this option is set the Viewer will automatically turn the page once every few 
seconds. The time interval is controllable from the Animate Speed chosen from the group box beneath 
this option. Slow = about 4 seconds, Medium = about 2 and Fast = about 1 second between pages.

These properties are recorded in your WIN.INI file when you close the Transcriber and are restored 
next time you use it.



The Transcript Text Window

This window is displayed when a page in a transcript has a text annotation and the Setup Preferences 
are set to Show Text Annotation .    Any other media such as sounds, bitmaps or other objects which the
student could examine are accessible from the button bar at the top of this window. Currently, only 
sound is supported on the button bar.



A TextStack is a Microsoft Viewer Document organized with the structure of a book that has a 
extension of .MVB. These electronic texts are the property of Keyboard Publishing and their contracted 
authors and may not be duplicated or re-published without permission.



A QuizBank is a Microsoft Viewer document that is set up to allow a student to review knowledge 
learned in a TextStack. The QuizBank keeps a running score of your answers and provides feedback 
and references from the original text.



A VideoIndex is a Microsoft Viewer Document that coordinates the display of videodisc images on a 
videodisc player. It takes advantage of the Multimedia Extensions provided in Windows 3.1. It will only 
function if you have a Media Control Interface Driver for you model of videodisc installed.



A Keyboard Viewer Document. Keyboard Publishing publishes electronic texts using a display 
program furnished my the Microsoft Corporation called Multimedia Viewer. You must have a copy of the 
Multimedia Viewer on your hard drive to view our books. Viewer documents can include Hypertext, 
Color Bitmaps, Audio Playback and Animation and have the extension .MVB.



    A Text Annotation is text the instructor can add to a page in the book which is being used to create a 
transcript. These annotation will appear in a floating window above the text when the student plays back 
the transcript.



    An Audio Annotation is a sound captured via a multimedia sound board such as Creative Labs 
Sound Blaster or MediaVision's Pro Media Board. Sounds are stored in the transcript file and can be 
played back automatically during a student's review of the transcript or via a button in the Text annotation 
button bar. A sound driver and sound hardware are required for sound playback. Sound can be played by 
means of the PC Speaker driver but quality is very low.



The Text Annotation Dialog

This dialog allows you to attach or remove text from any given page in the transcript. Select the line in 
the Transcript Window that you would like to attach text to and then select the Text Annotation... 
Command from the Page Menu.This dialog provides an area where you may type text. To insert a hard 
return into your text use <CRTL> - <ENTER>. This will allow you to put line breaks into the text.

To remove a text annotation click on the Remove Button.



The Audio Annotation Dialog

This dialog box allows you to attach a sound to any page in the transcript. Select the page in the 
Transcript Window that you would like to annotate and select Audio Annotation... from the Page Menu. 
This will display a dialog box allowing you to start and stop the recorder. You may also use this dialog to
remove a sound by using the Remove Button.

The transcript editor records sound with a preset sampling frequency of 11 KHz and stores the sound 
directly into the transcript file. Sound playback is synchronous and will always occur before actual text is
displayed in your transcript.




